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Desktop publishing software This article may contain an excessive amount of intricate detail that may interest only a particular audience. Please help by spinning off or relocating any relevant information, and removing excessive detail that may be against Wikipedia's inclusion policy. (April 2023) (Learn how and when to remove this message) Adobe
InDesignAdobe InDesign 2020 running on macOS CatalinaDeveloper(s)Adobelnitial releaseAugust 31, 1999 (1999-08-31)Stable releaseCC 2025 (20.0.1) / November 2024; 7 months ago (2024-11) Written inC++[1]Operating systemWindows, macOSAvailable in24 languages[2]List of languagesEnglish, Arabic, Brazilian Portuguese, Chinese Simplified,
Chinese Traditional, Czech, Danish, Dutch, Finnish, French, German, Greek, Hebrew, Hungarian, Italian, Japanese, Korean, Norwegian, Polish, Russian, Spanish, Swedish, Turkish, Ukrainian, ZuluTypeDesktop publishingLicenseTrialware, Proprietary, termWebsiteadobe.com/indesign Adobe InDesign is a desktop publishing and page layout designing
software application produced by Adobe and first released in 1999. It can be used to create works such as posters, flyers, brochures, magazines, newspapers, presentations, books and ebooks. InDesign can also publish content suitable for tablet devices in conjunction with Adobe Digital Publishing Suite. Graphic designers and production artists are
the principal users. InDesign is the successor to Adobe PageMaker, which Adobe acquired by buying Aldus Corporation in late 1994. (Freehand, Aldus's competitor to Adobe Illustrator, was licensed from Altsys, the maker of Fontographer.) By 1998, PageMaker had lost much of the professional market to the comparatively feature-rich QuarkXPress
version 3.3, released in 1992, and version 4.0, released in 1996. In 1999, Quark announced its offer to buy Adobe[3] and to divest the combined company of PageMaker to avoid problems under United States antitrust law. Adobe declined Quark's offer and continued to develop a new desktop publishing application. Aldus had begun developing a
successor to PageMaker, code-named "Shuksan". Later, Adobe code-named the project "K2", and Adobe released InDesign 1.0 in 1999. InDesign exports documents in Adobe's Portable Document Format (PDF) and supports multiple languages. It was the first DTP application to support Unicode character sets, advanced typography with OpenType
fonts, advanced transparency features, layout styles, optical margin alignment, and cross-platform scripting with JavaScript. Later versions of the software introduced new file formats. To support the new features, especially typography, introduced with InDesign CS, the program and its document format are not backward-compatible. Instead,
InDesign CS2 introduced the INX (.inx) format, an XML-based document representation, to allow backward compatibility with future versions. InDesign CS versions updated with the 3.1 April 2005 update can read InDesign CS2-saved files exported to the .inx format. The InDesign Interchange format does not support versions earlier than InDesign
CS. With InDesign CS4, Adobe replaced INX with InDesign Markup Language (IDML), another XML-based document representation.[4] InDesign was the first native Mac OS X publishing software. With the third major version, InDesign CS, Adobe increased InDesign's distribution by bundling it with Adobe Photoshop, Adobe Illustrator, and Adobe
Acrobat in Adobe Creative Suite. Adobe developed InDesign CS3 (and Creative Suite 3) as universal binary software compatible with native Intel and PowerPC Macs in 2007, two years after the announced 2005 schedule, inconveniencing early adopters of Intel-based Macs. Adobe CEO Bruce Chizen said, "Adobe will be first with a complete line of
universal applications."[5] InDesign documentFilename extension .inddInternet media type application/x-indesignOpen format?noWebsite The MIME type is not official File Open formats: indd, indl, indt, indb, inx, idml, pmd, xgx New File formats: indd, indl, indb File Save As formats: indd, indt Save file format for InCopy: icma (Assignment file) icml
(Content file, Exported file) icap (Package for InCopy) idap (Package for InDesign) File Export formats: pdf, idml, icml, eps, jpg, txt, XML, rtf[6] Newer versions can, as a rule, open files created by older versions, but the reverse is not true. Current versions can export the InDesign file as an IDML file (InDesign Markup Language), which can be opened
by InDesign versions from CS4 upwards; older versions from CS4 down can export to an INX file (InDesign Interchange format).[7][8] Adobe InDesign Server In October 2005, Adobe released InDesign Server CS2, a modified version of InDesign (without a user interface) for Windows and Macintosh server platforms. It does not provide any editing
client; rather, it is for use by developers in creating client-server solutions with the InDesign plug-in technology.[9][10] In March 2007 Adobe officially announced Adobe InDesign CS3 Server as part of the Adobe InDesign family. Paragraph styles are an essential tool for designers when working with text in Adobe InDesign.[11] Despite their menacing
appearance, they are straightforward to operate. Other features that make InDesign a good tool for working with text and paragraphs include: Creating frames and shapes[12] Aligning objects with grids and guides[12] Manipulating objects[12] Organizing objects[13] Importing text[13] Formatting text[13] Spell checking[13] Importing images[12]
Parent pages [14] (formerly master pages[12]) Paragraph styles[12] InDesign Middle Eastern editions have unique settings for laying out Arabic or Hebrew text. They feature: Text settings: Special settings for laying out Arabic or Hebrew text, such as: Ability to use Arabic, Persian or Hindi digits; Use kashidas for letter spacing and full justification;
Ligature option; Adjust the position of diacritics, such as vowels of the Arabic script; Justify text in three possible ways: Standard, Arabic, Naskh[further explanation needed]; Option to insert special characters, including Geresh, Gershayim, Maqaf for Hebrew and Kashida for Arabic texts; Apply standard, Arabic, or Hebrew styles for page, paragraph,
and footnote numbering. Bi-directional text flow: Right-to-left behavior applies to several objects: Story, paragraph, character, and table. It allows mixing right-to-left and left-to-right words, paragraphs, and stories in a document. Changing the direction of neutral characters (e.g., / or ?) is possible according to the user's keyboard language.[15] Table
of contents: Provides a table of contents titles, one for each supported language. This table is sorted according to the chosen language. InDesign CS4 Middle Eastern versions allow users to select the language of the index title and cross-references. Indices: This allows the creation of a simple keyword index or a somewhat more detailed index of the
information in the text using embedded indexing codes. Unlike more sophisticated programs, InDesign cannot insert character style information as part of an index entry (e.g., when indexing book, journal, or movie titles). Indices are limited to four levels (the top level and three sub-levels). Like tables of contents, indices can be sorted according to the
selected language. Importing and exporting: Can import QuarkXPress files up to version 4.1 (1999), even using Arabic XT, Arabic Phonyx, or Hebrew XPressWay fonts, retaining the layout and content. Includes 50 import/export filters, including a Microsoft Word 97-98-2000 import filter and a plain text import filter. Exports IDML files can be read by
QuarkXPress 2017. Reverse layout: Include a reverse layout feature to reverse the layout of a document when converting a left-to-right document to a right-to-left one or vice versa. Complex script rendering: InDesign supports Unicode character encoding, and Middle Eastern editions support complex text layouts for Arabic and Hebrew complex
scripts. The underlying Arabic and Hebrew support is present in the Western editions of InDesign CS4, CS5, CS5.5, and CS6, but the user interface is not exposed, making it difficult to access. Comparison of desktop publishing software List of desktop publishing software ©~ Lextrait, Vincent (January 2010). "The Programming Languages Beacon,
v10.0". Retrieved March 14, 2010.[dubious - discuss] © "language versions | Adobe InDesign CS5". Adobe.com. Retrieved December 4, 2010. ©~ Marsh, Ann (May 31, 1999). "Pride goeth before destruction". Forbes. Archived from the original on August 28, 2017. Retrieved February 5, 2013. ~ "InDesign developer documentation". Adobe Developer
Connection. Adobe Systems. Retrieved November 24, 2013. ™ San Francisco - Live Coverage of Steve Jobs Keynote 1:00 PM EDT, June 6th, 2005, WWDC 2005 - Live Coverage of Keynote, The Mac Observer ~ "Supported file formats for InDesign CS5". helpx.adobe.com. Retrieved December 6, 2019. ™ "How do I save my file using InDesign CS6 so
that it can be opened with CS5?". forums.adobe.com. January 2013. Retrieved January 28, 2015. ©~ "Can You Save/Open CS6 Files on CS5, CS4 or CS3 - and Vice Versa?". prodesigntools.com. February 20, 2013. Retrieved January 28, 2015. ©~ "Adobe InDesign Server CS2 Frequently Asked Questions" (PDF). Adobe.com. Archived from the original
(PDF) on June 4, 2007. Retrieved April 29, 2007. ~ Dunn, Max. "The Greatest Software Product of All Time: A Developer's Appreciation of Adobe InDesign". Medium. Silicon Publishing. Retrieved May 20, 2023. ©~ "How to use InDesign paragraph styles | Redokun Blog". redokun.com. Retrieved May 4, 2023. ©~ a b c d e f Rubin, Mira (2011), "Adding
Media in Indesign", Interactive InDesign CS5, Elsevier, pp. 233-245, d0i:10.1016/b978-0-240-81511-4.50014-6, ISBN 9780240815114, retrieved May 11, 2022 ~ a b ¢ d Assadi, Barbara (2005). InDesign CS2 For Dummies. John Wiley & Sons. ISBN 978-0-7645-9572-1. OCLC 940844080. ©~ "Parent pages". Adobe InDesign User Guide. January 17, 2022.
Retrieved March 27, 2024. ©~ "Arabic and Hebrew features in InDesign". Adobe InDesign User Guide. Retrieved August 7, 2018. Wikimedia Commons has media related to Adobe InDesign. Wikiversity has learning resources about Adobe InDesign Official website Retrieved from " November 22, 2022Karolin Koestler, Senior Marketing Manager EMEA
InDesign is used by graphic designers, artists, publishers, and marketing professionals all over the world. They use this software program to create flyers, brochures, magazines, newspapers, posters, business cards, postcards, and many other types of documents for any number of organizations. Yet, although InDesign is an Adobe product, and while
Adobe created the PDF format in the nineties, it wasn’t until recently that they included native support for them in InDesign. While graphic designers will probably have used plugins or other tricks to get it to work, this recent development makes it possible to use PDFs in InDesign directly. InDesign’s older versions required you to use a plugin to
open PDF files. You can now import them and use the Place command to add them to a design. You can either place the entire PDF in an InDesign file, or just a few pages. Note that InDesign will remove any links, audio or video embedded in a PDF. Otherwise, everything works perfectly. To make the process work correctly, your PDF must not be
password protected. Here’s all you need to do. Open your project in InDesign.Choose File and Place.Now check the Show Preview box.Select Show Import Options, and then choose the PDF file. Choose the page or pages, or, if you wish, choose an entire document that you wish to place.To open the PDF in InDesign, select Open. A preview should
appear in the Import Options window. This will show you how the PDF will look inside your design. InDesign imports at the highest resolution by default, so you can make any adjustments later. You can choose to import a single page or a range of pages. You can crop, select individual layers and set them as placeable art, trim, bleed to print, and add
media restrictions to preserve the PDF’s original format and size. InDesign is designed for desktop publishing and images. It will not work well with large PDF files. Splitting large PDF files into pages is a better option. Then you can add each page to InDesign. Although it takes some time, this makes the process much more manageable. Share — copy
and redistribute the material in any medium or format for any purpose, even commercially. Adapt — remix, transform, and build upon the material for any purpose, even commercially. The licensor cannot revoke these freedoms as long as you follow the license terms. Attribution — You must give appropriate credit , provide a link to the license, and
indicate if changes were made . You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use. ShareAlike — If you remix, transform, or build upon the material, you must distribute your contributions under the same license as the original. No additional restrictions — You may not apply legal terms or
technological measures that legally restrict others from doing anything the license permits. You do not have to comply with the license for elements of the material in the public domain or where your use is permitted by an applicable exception or limitation . No warranties are given. The license may not give you all of the permissions necessary for
your intended use. For example, other rights such as publicity, privacy, or moral rights may limit how you use the material. November 22, 2022Karolin Koestler, Senior Marketing Manager EMEA InDesign is used by graphic designers, artists, publishers, and marketing professionals all over the world. They use this software program to create flyers,
brochures, magazines, newspapers, posters, business cards, postcards, and many other types of documents for any number of organizations. Yet, although InDesign is an Adobe product, and while Adobe created the PDF format in the nineties, it wasn’t until recently that they included native support for them in InDesign. While graphic designers will
probably have used plugins or other tricks to get it to work, this recent development makes it possible to use PDFs in InDesign directly. InDesign’s older versions required you to use a plugin to open PDF files. You can now import them and use the Place command to add them to a design. You can either place the entire PDF in an InDesign file, or just
a few pages. Note that InDesign will remove any links, audio or video embedded in a PDF. Otherwise, everything works perfectly. To make the process work correctly, your PDF must not be password protected. Here’s all you need to do. Open your project in InDesign.Choose File and Place.Now check the Show Preview box.Select Show Import
Options, and then choose the PDF file. Choose the page or pages, or, if you wish, choose an entire document that you wish to place.To open the PDF in InDesign, select Open. A preview should appear in the Import Options window. This will show you how the PDF will look inside your design. InDesign imports at the highest resolution by default, so you
can make any adjustments later. You can choose to import a single page or a range of pages. You can crop, select individual layers and set them as placeable art, trim, bleed to print, and add media restrictions to preserve the PDF’s original format and size. InDesign is designed for desktop publishing and images. It will not work well with large PDF
files. Splitting large PDF files into pages is a better option. Then you can add each page to InDesign. Although it takes some time, this makes the process much more manageable. , the free encyclopedia that anyone can edit. 110,331 active editors 7,023,877 articles in English Igor Judge, Baron Judge, a British judge Nominative determinism is the
hypothesis that people are drawn to professions that fit their name. The term was first used in the magazine New Scientist in 1994, after its humorous Feedback column mentioned a book on polar explorations by Daniel Snowman and an article on urology by researchers named Splatt and Weedon. The hypothesis had been suggested by psychologist
Carl Jung, citing as an example Sigmund Freud (German for 'joy'), who studied pleasure. A few recent empirical studies have indicated that certain professions are disproportionately represented by people with appropriate surnames, though the methods of these studies have been challenged. One explanation for nominative determinism is the theory
of implicit egotism, which states that humans have an unconscious preference for things they associate with themselves. An alternative explanation is genetic: an ancestor might have been named Smith or Taylor according to their occupation, and the genes they passed down might correlate to aptitudes for those professions. (Full article...) Recently
featured: Donkey Kong Land History of education in Wales (1701-1870) White dwarf Archive By email More featured articles About Congregation Shaar Hashomayim ... that the Congregation Shaar Hashomayim (pictured) in Windsor, Ontario, was modelled after a synagogue in Montreal? ... that NASA promoted the "faster, better, cheaper" approach
to spacecraft missions in the 1990s? ... that Black model Debra Shaw walked the runway in Bellmer La Poupée wearing a metal frame that generated controversy over a perceived reference to slavery? ... that a spokesman for the Kaw Nation credited Robert L. Rankin with single-handedly preserving their language? ... that multiple members of various
royal families have competed in the Olympics? ... that The Westerlies folded a piece of tin foil over the bell of a trombone to make it hiss? ... that after runner Frej Liewendahl had broken Paavo Nurmi's five-year winning streak, he went to his hotel room with flowers to apologise? ... that the crew of the US Coast Guard Cutter Dione repeatedly
attacked the shipwrecks of oil tankers, believing them to be German U-boats? ... that one issue facing tsunami sirens in New Zealand has been a youth subculture that steals sirens to compete for the loudest and clearest sound? Archive Start a new article Nominate an article Trifid and Lagoon nebulae The Vera C. Rubin Observatory in Chile releases
the first light images (example shown) from its new 8.4-metre (28 ft) telescope. In basketball, the Oklahoma City Thunder defeat the Indiana Pacers to win the NBA Finals. An attack on a Greek Orthodox church in Damascus, Syria, kills at least 25 people. The United States conducts military strikes on three nuclear facilities in Iran. In rugby union, the
Crusaders defeat the Chiefs to win the Super Rugby Pacific final. Ongoing: Gaza war Iran-Israel war Russian invasion of Ukraine timeline Sudanese civil war timeline Recent deaths: John R. Casani Richard Gerald Jordan Franco Testa Raymond Laflamme Gertrud Leutenegger Maria Voce Nominate an article June 27: Helen Keller Day in the United
States Depiction of Pope Agatho 678 - Pope Agatho (depicted), later venerated as a saint in both the Catholic and Eastern Orthodox churches, began his pontificate. 1800 - War of the Second Coalition: French forces won a victory at the Battle of Neuburg, ending Austrian control over the River Danube. 1905 - First Russian Revolution: The crew of the
Russian battleship Potemkin began a mutiny against their officers. 1950 - Korean War: Five North Korean aircraft attacked an American air convoy above Suwon Air Base in the first air engagement of the Korean War. 2015 - Ignition of corn starch caused a dust fire at a water park in New Taipei City, Taiwan, killing 12 people and injuring more than
400 others. Wilhelmina FitzClarence, Countess of Munster (b. 1830)Frank Rattray Lillie (b. 1870)Harry Pollitt (d. 1960)Nico Rosberg (b. 1985) More anniversaries: June 26 June 27 June 28 Archive By email List of days of the year About 2024 variant of the Men's T20 World Cup logo The ICC Men's T20 World Cup, formerly the ICC World Twenty20, is
a biennial world cup for cricket in the Twenty20 International (T20I) format, organised by the International Cricket Council (ICC). It was held in every odd year from 2007 to 2009, and since 2010 has been held in every even year with the exception of 2018 and 2020. In 2018, the tournament was rebranded from the World Twenty20 to the Men's T20
World Cup. As of the 2024 tournament, twenty-four nations have played in the T20 World Cup. Nine teams have competed in every tournament, six of which have won the title. The West Indies, England and India have won the title twice each, while Pakistan, Sri Lanka and Australia have won the title once each. Sri Lanka, England, Pakistan and India
have each made three final appearances, while Pakistan have also made six semi-final appearances. The best result by a non-Test playing nation is the second round appearance by the United States in 2024, while the worst result by a Test playing nation is the second round appearance by Zimbabwe in 2022. (Full list...) Recently featured: Michelin-
starred restaurants in Turkey Timeline of Partygate Songs by Gen Hoshino Archive More featured lists Whitehead's trogon (Harpactes whiteheadi) is a species of bird in the family Trogonidae. It is endemic to the island of Borneo, where it is an uncommon resident in primary mountain forest. One of Borneo's largest trogons, at 29 to 33 centimetres
(11 to 13 inches) long, it is sexually dimorphic. The male is crimson on the head, nape, and underparts, with a black throat and grey chest; the rest of its upperparts are cinnamon-coloured. The female is similarly patterned, but cinnamon-brown where the male is scarlet. The species is primarily an insectivore, but also eats various plant materials,
including fruits and seeds. Other than the timing of its breeding, typically between April and June, little is known about its breeding biology. It is classified as a near-threatened species, with population numbers thought to be declining and habitat loss a key threat. This male Whitehead's trogon was photographed perching on a branch near Mount
Kinabalu in the Malaysian state of Sabah. Photograph credit: John Harrison Recently featured: Atacamite Turban Head eagle Springbok Archive More featured pictures Community portal - The central hub for editors, with resources, links, tasks, and announcements. Village pump - Forum for discussions about Wikipedia itself, including policies and
technical issues. Site news - Sources of news about Wikipedia and the broader Wikimedia movement. Teahouse - Ask basic questions about using or editing Wikipedia. Help desk - Ask questions about using or editing Wikipedia. Reference desk - Ask research questions about encyclopedic topics. Content portals - A unique way to navigate the
encyclopedia. Wikipedia is written by volunteer editors and hosted by the Wikimedia Foundation, a non-profit organization that also hosts a range of other volunteer projects: CommonsFree media repository MediaWikiWiki software development Meta-WikiWikimedia project coordination WikibooksFree textbooks and manuals WikidataFree knowledge
base WikinewsFree-content news WikiquoteCollection of quotations WikisourceFree-content library WikispeciesDirectory of species WikiversityFree learning tools WikivoyageFree travel guide WiktionaryDictionary and thesaurus This Wikipedia is written in English. Many other Wikipedias are available; some of the largest are listed below. 1,000,000+
articles a2/l Deutsch Espafiol w8 Francais Italiano Nederlands H#:E Polski Portugués Pycckuit Svenska Vkpainceka Tiéng Viét 13X 250,000+ articles Bahasa Indonesia Bahasa Melayu Ban-1am-gi Benrapcku Catala Cestina Dansk Eesti EAAnuik& Esperanto Euskara nnay 2uytintii Magyar Norsk bokmél Roméana Simple English Slovencina Srpski
Srpskohrvatski Suomi Tiirkge O‘zbekcha 50,000+ articles Asturianu Azerbaycanca [J00] Bosanski s ,sS Frysk Gaeilge Galego Hrvatski Jo®mgeo Kurdi Latviesu Lietuviu 00000 Makemoucku (000000000 Norsk nynorsk 000000 Shqip Slovensc¢ina (00 000000 so,! Retrieved from " 2 This article is about the year 678. For the film, see 678 (film). For the
Argentine TV program, see 6, 7, 8. Calendar year Years Millennium 1st millennium Centuries 6th century 7th century 8th century Decades 650s 660s 670s 680s 690s Years 675 676 677 678 679 680 681 vte 678 by topic Leaders Political entities State leaders Religious leaders Categories Births Deaths Establishments vte 678 in various
calendarsGregorian calendar678DCLXXVIIIADb urbe condital431Armenian calendar127(3J XhEAssyrian calendar5428Balinese saka calendar599-600Bengali calendar84-85Berber calendar1628Buddhist calendar1222Burmese calendar40Byzantine calendar6186-6187Chinese calendar] A (Fire Ox)3375 or 3168 — to —/X&E (Earth Tiger)3376 or
3169Coptic calendar394-395Discordian calendar1844Ethiopian calendar670-671Hebrew calendar4438-4439Hindu calendars - Vikram Samvat734-735 - Shaka Samvat599-600 - Kali Yuga3778-3779Holocene calendar10678Iranian calendar56-57Islamic calendar58-59Japanese calendarHakuchi 29(EH%f 2 9 &F)Javanese calendar570-571Julian
calendar678DCLXXVIIIKorean calendar3011Minguo calendar1234 before ROCR#112345& Nanakshahi calendar—790Seleucid era989/990 AGThai solar calendar1220-1221Tibetan calendarfA:X 4 (female Fire-Ox)804 or 423 or —349 — to —fHLXE S (male Earth-Tiger)805 or 424 or —348 Pope Agatho I (678-681) Year 678 (DCLXXVIII) was a common
year starting on Friday of the Julian calendar. The denomination 678 for this year has been used since the early medieval period, when the Anno Domini calendar era became the prevalent method in Europe for naming years. July 27 - The Siege of Thessalonica (676-678) ends, when the Sclaveni withdraw. Autumn - Siege of Constantinople: Emperor
Constantine IV confronts the Arab besiegers in a head-on engagement. The Byzantine fleet, equipped with Greek fire, destroys the Muslim fleet at Sillyon,[1][2][3][4] ending the Arab threat to Europe, and forcing Yazid (a son of caliph Muawiyah I) to lift the siege on land and sea. The victory also frees up forces that are sent to raise the two-year siege
of Thessalonica by the local Slavic tribes. King Zthelred of Mercia defeats the Northumbrian forces under King Ecgfrith, in a battle near the River Trent. Archbishop Theodore helps to resolve differences between the two, ZLthelred agreeing to pay a weregild to avoid any resumption of hostilities (approximate date). April 27 - Emperor Tenmu holds
divination for the purpose of proceeding to the Abstinence Palace. May 3 - Princess Tochi suddenly takes ill and dies within the palace. Tenmu, her father, is unable to sacrifice to the Gods of Heaven and Earth. May 10 - Tochi is buried at a place which could be Ako (Hyogo Prefecture). Tenmu is graciously pleased to raise lament for her. Wilfrid,
bishop of York, is at the height of his power and owns vast estates throughout Northumbria. After his refusal to agree to a division of his see, Ecgfrith and Theodore, archbishop of Canterbury, have him banished from Northumbria. April 11 - Pope Donus dies at Rome, after a reign of 1 year and 160 days. He is succeeded by Agatho I, who becomes the
79th pope. He is the first pope to stop paying tribute to Emperor Constantine IV upon election. In Japan, the national worshiping to the Gods of Heaven and Earth is planned. Tenmu tries to select his daughter Tochi as a Saio to make her serve the Gods. However, Tochi suddenly takes ill and dies. The Beomeosa temple complex in Geumjeong-gu
(modern South Korea) is constructed, during the reign of King Munmu of Silla. Childebert III, Merovingian Frankish king and son of Theuderic III Childebrand I, duke of Burgundy (d. 751) K’inich Ahkal Mo’ Nahb III, Maya ruler of Palenque April 11 - Pope Donus May 3 - Tochi, Japanese princess Abdullah ibn Aamir, Arab general (b. 626) ZElfwine,
king of Deira (approximate date) Aisha, wife of Muhammad Arbogast, bishop of Strasbourg Nathalan, Scottish bishop Wechtar, Lombard duke of Friuli Zhang Wenguan, chancellor of the Tang dynasty (b. 606) ~ Haldon 1990, p. 64. ~ Lilie 1976, pp. 78-79. ™ Treadgold 1997, pp. 326-327. ™~ Mango & Scott 1997, p. 494. Haldon, John F. (1990).
Byzantium in the Seventh Century: The Transformation of a Culture (revised ed.). Cambridge University Press. ISBN 978-0-521-31917-1. Lilie, Ralph-Johannes (1976). Die byzantinische Reaktion auf die Ausbreitung der Araber. Studien zur Strukturwandlung des byzantinischen Staates im 7. und 8. Jhd [Byzantine Reaction to the Expansion of the
Arabs. Studies on the Structural Change of the Byzantine State in the 7th and 8th Cent.] (in German). Munich: Institut fir Byzantinistik und Neugriechische Philologie der Universitat Miinchen. OCLC 797598069. Mango, Cyril; Scott, Roger (1997). The Chronicle of Theophanes Confessor. Byzantine and Near Eastern History, AD 284-813. Oxford
University Press. ISBN 0-19-822568-7. Treadgold, Warren (1997). A History of the Byzantine State and Society. Stanford, California: Stanford University Press. ISBN 0-8047-2630-2. Retrieved from " 32009 Argentine TV series or program 6, 7, 8First logoAlso known asThe Critique to Real PowerGenreArchive television programPresented by Orlando
Barone Carlos Barragan Jorge Dorio Cynthia Garcia Eduardo Massa Alcantara Mariana Moyano Dante Palma Sandra Russo Nora Veiras Country of originArgentinaOriginal languageSpanishNo. of seasons7ProductionExecutive producerDiego GvirtzProducerPensado Para TelevisionOriginal releaseNetworkTelevision Piblica ArgentinaReleaseMarch 9,
2009 (2009-03-09) -23 December 2015 (2015-12-23) Six in the Seven at Eight, usually called 6, 7, 8, was an Argentine political commentary TV program broadcast by the government-run Channel 7 since 2009. Its name comes from the fact that, when it first started airing, there were five members on the show's panel, and its motto was you are the
sixth one (the viewer). Since it was broadcast by Channel 7 at 8 p.m., the name was shortened to "6, 7, 8". In late 2009, the program was moved to 9 p.m., a new segment was added to be aired on Sundays at night, and new guest panelists were invited, making it more than six members.[1] Nevertheless, the show's name remained unchanged. It was
first hosted by Maria Julia Olivan and a panel which included Orlando Barone, Carla Czudnowsky, Eduardo Cabito Massa Alcantara, Luciano Galende and Sandra Russo, along with a guest analyst who would give their opinions throughout the program. Maria Julia Olivdn announced in an interview for web site Television.com.ar that, on January 28,
2010, should make her last appearance on the program.[2] Her place was occupied by Luciano Galende, and from 2013 onward the host has been Carlos Barragan. The program was nominated to the 2010 Martin Fierro Awards in the category Best Journalistic Program. The program's panel discussed national and world events and analyzed their
social and political repercussions on Argentina. The program has come under criticism due to its perceived advocacy of Kirchnerism, which is controversial since it is aired by a state-owned TV channel during the time when Cristina Kirchner was president. The program ceased to be aired shortly after the end of the presidency of Cristina Kirchner. 6,
7, 8 was first aired on March 9, 2009. The initial name was "6 in the 7 at 8", making reference to the 6 people in the program, the channel Television Publica Argentina that airs in channel 7, and that the program was broadcast at 8:00 pm. Although the number of people and the timeslot changed over time, the name "678" was kept. It is an Archive
television program focused on politics and journalism. It was created during the campaign for the 2009 midterm elections, in order to broadcast the Kirchnerite propaganda known as Relato K, and to attack the opposing candidates. It received a privileged timeslot on Sundays, right after the broadcasting of the Fitbol para todos weekly matches.
Once the elections were over, it continued to voice the Kirchnerite view in the conflict between Kirchnerism and the media.[3] Mauricio Macri, president of Argentina since December 10, 2015, appointed Hernan Lombardi as the new manager for Channel 7. Soon thereafter it was announced that the channel would not air 6, 7, 8 because the
production company decided not to renew the contract with the TV Publica.[4][5] According to Clarin newspaper the program uses archive footage to criticize Mass Media outlets, judges and political opponents to the national government.[6] On October 13, 2009 the program aired a video that had circulated in blogs. The anonymous video was
recorded through a hidden camera, and it shows the journalist and columnist of newspaper La Nacién, Carlos Pagni, in an alleged operation to publish false information for the purpose of damaging the oil company Repsol YPF. The broadcast of the video was criticized by the Partido Solidario deputy Carlos Heller who was a guest on the program that
day, expressing his objection to the publication of anonymous films. The contents of the video were criticized by the panelists after it was shown. According to an article in La Nacion that was published the next day about the segment, "the presentation of the hidden camera, and the images of the hidden camera (cut, but carefully and professionally
edited) do not, at any moment, show the columnist in situations that could corroborate the serious and injurious charges about corruption that are made in the video through printed boards and a voice-over".[7] In the video, there are appearances by other people who may represent Pagni, receiving money in return for newspaper articles. However,
after the airing on October 13, Pagni received the support of the Argentine Journalism Forum (Foro del Periodismo Argentino) and other journalists.[8] YPF issued a complaint to investigate who recorded the video, and the veracity of the facts that are seen on it. They assured that "it is true that the video is anonymous and made in a more obscure
way. However, it warns that it was a journalistic operation against us".[9] 2013 Martin Fierro Awards Best journalism program[10] ~ Asteriscos.tv Seis, siete, ocho ¢y ahora a las nueve? (in Spanish) ~ "6, 7, 8 en TVPublica.com.ar". Archived from the original on 2013-08-04. Retrieved 2010-04-16. ~ Olivan, pp. 9-12 ©~ "Chau 6, 7, 8". Archived from the
original on 2015-11-25. Retrieved 2015-11-24. ~ "Adiés 678". ~ Clarin.com, «El programa que ataca a los medios criticos cuesta caro» Archived 2010-01-13 at the Wayback Machine (in Spanish) ~ La Nacién.com, «Agravia Canal 7 a un columnista con un video anénimo» Archived 2011-06-05 at the Wayback Machine (in Spanish) ~ Cable en
Minutouno Archived 2011-07-06 at the Wayback Machine (in Spanish) ~ “Igual hubo una operacion”, por Ratl Kollmann (in Spanish) ~ "Todos los nominados a los Martin Fierro 2014" [All the nominations for the 2014 Martin Fierro]. La Nacion (in Spanish). April 15, 2014. Retrieved April 15, 2014. Olivan, Maria Julia (2010). 678: La creacién de otra
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knowledge and solutions when working with PDF files and InDesign. We cover the topics of Importing a PDF into InDesign as a static object and separately Converting a PDF into an InDesign document type which is editable.IntroductionAdobe InDesign is the go-to product for your daily Desktop Publishing needs. Many a times, we need to reuse an
existing PDF within InDesign depending on the project at hand.Generally, when we get a PDF file, we immediately think of using Adobe Acrobat as it provides a wide range of PDF manipulation options; however, Acrobat doesn’t offer the flexibility that InDesign provides in terms of Desktop publishing workflow.PDF Processing with InDesignExplained
below are 2 distinct and separate processes of Importing a PDF into InDesign and Converting a PDF into InDesign type.1. Importing a PDF file into InDesignThe objective of importing a PDF into InDesign is for it to be placed as static data (like an image).Importing a PDF into InDesign is used primarily when you have some assets that already exists as
a PDF, and you don’t want it to be edited and/or you simply need to include a small section of the PDF as a static object to an existing document.Importing a PDF into InDesign and using it as a placed object is done by following the instructions below:A. Create a New InDesign document or Open an existing InDesign file then Select the Place command
and choose the PDF file to ImportB. When the Place PDF options window appears, specify the settings, and click OKC. The PDF is imported into the InDesign file2. Converting a PDF to InDesign typeConverting a PDF to a native InDesign file requires a plug-in like PDF2ID. That’s because InDesign can’t convert any PDF to an editable InDesign file (it
can only place the PDF as a static object as explained above). PDF2ID converts the PDF file in your computer itself without uploading anything to the cloud thus ensuring your data is 100% secure.The purpose of converting a PDF to native InDesign type is to so that you can recover the assets such as graphics, text, images, tables, and other data in
the PDF (which may include Form objects or even Accessibility tags) and have it laid out in a proper desktop publishing fashion. Once the PDF is converted to an InDesign file, you can edit everything within it (you can update the layout and move things around all you want). Also, having all assets recovered natively to the InDesign file provides
flexibility where you can revisit the document later to change it, or even export it to the epub or other types using InDesign.There are other reasons why you need to use a plug-in like PDF2ID to directly convert a PDF to InDesign (instead of going through a route like converting the PDF to RTF or another format). When using PDF2ID, all color spaces
in the PDF (Lab, CMYK, RGB) and detailed information such as clipping path’s, masks, and other properties such as drop shadows, drop caps get accurately formed. Thus, this direct method allows for maximum precision.For digitally produced PDF files, PDF2ID works extremely well. If the PDF was created by a scanner or say a fax then generally
such PDF contain only images. In such a case you want to use the OCR (Optical Character Recognition) first (using Acrobat DC or a similar product). We have a reference article that goes into detail about this also.To convert a PDF to InDesign type using PDF2ID we simply use the steps below:A. Click the Recosoft menu in InDesign and choose the
PDF2ID - Convert PDF/XPS file commandB. Choose the PDF to convert and when the PDF2ID - Options window appears, click OKC. The PDF is converted to a fully editable InDesign documentClosingWe hope this article elucidated the differences between Importing a PDF into InDesign and Converting a PDF to an editable InDesign type using a
product like PDF2ID. An InDesign document contains styles and linked files. It can be used for desktop publishing to create books, flyers, newspapers, and magazines. The PDF file format is the commonly used file but it can't be opened and edited by InDesign, so sometimes you may be required to convert your PDF document into an InDesign
document for various uses. This article explains the commonly-used way to convert PDF to InDesign. Tip: If you need to edit PDF files, such as changing text or images, deleting or adding pages, or reordering pages, you can use Wondershare PDFelement - PDF Editor Wondershare PDFelement Wondershare PDFelement. PDFelement is packed with
professional tools that help you convert, edit, transform, and organize PDFs with ease. With it, you can convert PDF into various file formats. The supported output formats include, Word, Excel, PowerPoint files, JPG, JPEG, TXT, RTF, TIFF, RTF, EPUB, and HTML. Convert PDF to InDesign and Edit for Free Convert PDF to InDesign on the Latest
Version Adobe InDesign now adds a long-requested capability that allows users to convert PDF files directly into editable InDesign (.INDD) documents. If you are using the latest version of InDesign, you can convert PDF to InDesign by simply opening the file in the program. Here is how it works. Step 1. Launch Adobe InDesign. Go to File > Open and
select your PDF file. Step 2. Once the PDF file is opened, it will be converted to InDesign Document and the PDF content appears as native InDesign elements—editable text frames, placed images, and vector objects. However, there are some limitations when opening PDF files in InDesign. File type: It only works with PDFs originally created in
InDesign. Software version: The new feature is now available only in the latest version of InDesign in the English language. Layout Accuracy: While InDesign does a great job of preserving layout, complex formatting or layered designs may not be reproduced perfectly. Unsupported element: InDesign will remove any links, audio, or video embedded in
a PDF. Convert PDF to InDesign on the Older Version If you are using the older version of InDesign, you can open a PDF file in InDesign by placing the file into your InDesign files. Firstly, click the File menu on InDesign and select Place. This will open the Place dialog window. Now you can select the PDF file to import to InDesign. You can also import
JPG, EPS, RTF, etc. to InDesign by the placing button. Make sure that you have ticked the Show Import Options setting and then click OK. Use a PDF to Indesign Converter Option 1: Download PDF to Indesign Converter You can easily convert PDF files into InDesign. The most commonly used PDF to InDesign converter is Recosoft PDF2ID, which is a
plugin that can analyze data of the PDF file and reconstructe the file in InDesign supported format. PDF2ID offers a free trial and paid plans starting from $99.99/per year. However, many users found that PDF2ID only work well in converting basic PDF files to INDD files. To convert PDF to InDesign using Recosoft, you can follow these steps. Step 1.
To open and convert the PDF files using the PDF2ID, select the command "PDF2ID- Convert PDF/XPS" from the Recosoft menu. Step 2. Select the PDF that you want to open to InDesign and then click "OK". Step 3. When the PDF2ID (PDF to InDesign) appears, hit "OK" to convert PDF to InDesign. You can also specify the conversion options before
clicking "OK". Step 4. The PDF will be converted to InDesign which you can edit. The conversion takes a few seconds depending on the size of the file. Option 2: Online PDF to Indesign Converter Leguptools is an online platform that provides utilities for converting and editing InDesign-related files. One of its useful tools allows you to convert a PDF
into an IDML file, which can be opened in Adobe InDesign on CS4 and newer. Steps to Convert PDF to InDesign (IDML) using Leguptools: Step 1. Go to Leguptools online PDF to InDesign converter. Step 2. Click the "Convert your PDF file" button or drag and drop your PDF into the upload area. Wait for the file to upload completely. Step 3. Click the
"Convert" button to begin the process. The system will process the file and convert it into an IDML file. Step 4. Once the conversion is complete, download your converted file. Step 5. Then launch Adobe InDesign. Use File > Open to open the downloaded .idml file. The document should open with editable text, images, and layout elements. Tips
Converting PDF to InDesign using Leguptools cost $0.25 per page. Leguptools can handle PDF files created by InDesign, Adobe Express, Illustrator, Excel, Gamma, Google Docs, and Canva. The PDF files you upload to Leguptools should not be more than 100 pages or larger than 25MB in size. If this is a scanned PDF file, Leguptools can only convert
it to non-editable image. How to Edit PDF Files without InDesign If you need to edit the PDF files, you can use PDFelement. Its editing tools help you change images and text easily, and manage the PDF pages. You can also add notes and create custom stamps, highlight, and strikeout texts in a PDF file. The advanced OCR feature even gives you the
possibility of editing scanned PDF documents. G2 Rating: 4.5/5 |100% Secure Step 1: Import PDF First, simply drag the pdf file into the software window. You can also click the "Open File..." button and browse the PDF files you want to import. Step 2: Edit PDF Files Click the Edit tab, where you can find the options to edit text, images, watermark,
and background of the PDF files. You can also click the Organize tab, where you can combine, split, delete, and reorder pages. Step 3: Convert PDF Files to Other Formats Go to the "Home" tab and then "Word" or "To Others" to enable conversion. A dialog box will appear where you will be able to select the output folder to enable saving the
converted file. You can change the output file format by choosing the "Save a Type" option. Free Download or Buy PDFelement right now! Free Download or Buy PDFelement right now! Try for Free right now! Try for Free right now! Adobe InDesign is a well-known desktop software that is used to create digital materials like ebooks, presentations,
etc. With an editable .indd or .indt file, you are able to develop efficient work by modifying the text, images, and other adjustments. Can I convert a PDF file to InDesign? Can you edit a PDF file in InDesign? How can you convert PDF to InDesign online for free? No worry. In this post, several effective methods are introduced to you on how to convert
PDF to InDesign. Here is a short guide on converting PDF to InDesign: How to Convert PDF to InDesign Converting your files like PDF to InDesign helps enrich the content and enhances your workflow automation. In this part, we offer two options for you to do so: Convert PDF to InDesign with Plugin Convert PDF to InDesign without Plugin These
ways apply to the following cases: Convert PDF to InDesign editable Convert PDF to InDesign for free Download PDF to InDesign converter online for free Select one based on your needs and share these methods on your social media to help more users. Guide 1. Convert PDF to InDesign with Plugin To open PDFs in InDesign, apply the extension tool
on your Adobe design software. PDF2DTP and PDF2ID are both helpful as PDF to InDesign converters. Add one of these plugins to your InDesign CC. Tool 1. PDF2DTP To get an editable InDesign file from a PDF, it's necessary to have an effective plug-in like PDF2DTP. This tool allows making an effective conversion, creating a new INDD or INDT file
with the original information over from PDF. Also, one incredible feature is that it can handle multiple PDF pages, saving you much time. This plug-in is helpful as it is compatible with InDesign CC 2020, CC 2019, and other older versions on Windows and Mac. Compatibility of PDF2DTP: Windows: Can be used on Windows XP or above Mac: For
macOS X 10.6 or higher Followed is a list of simple steps to obtain INDD and INDT files from PDFs with PDF2DTP: Step 1. Open the Adobe software with this plugin. Click "Markzware" > "PDF2DTP" > "Convert PDF...". Before conversion, you can choose to convert all PDFs or certain pages by clicking "Preferences." Step 2. Now, choose your

target PDF from your computer and click "Open." Step 3. After that, wait for the processing dialog window, and you can save the new file in a few seconds. You may also be interested in>>[PDF vs PDF/A] What's the Difference and How to Convert Tool 2. PDF2ID Another solution to get an editable InDesign file from PDF is using the PDF2ID plug-

in, providing accurate transformation for all documental elements. With it, you don't need to manually paste the content into InDesign. Meanwhile, you have the option to convert the whole PDF file or some part of the PDF. It's a good option to reset the file's layout by forming some elements. PDF2ID operates with Adobe InDesign CC 2025, CC 2020,
and other versions on Windows and Mac. Compatibility of PDF2ID: PC: Above Windows XP macOS: Mac OS X and other versions How to convert PDF to INDD using this PDF to InDesign plugin: Step 1. Firstly, click "Recosoft" in Adobe InDesign and select "PDF2ID". Then, choose "Convert PDF/XPS File". Step 2. This plugin allows customizing the
task. Based on your needs, you have more options in the "Preferences". Step 3. To finish it, click "OK" and wait for a while. Then, you get a satisfying INDD file with the original content. Guide 2. Convert PDF to InDesign Without Plugin Can I import a PDF into InDesign to edit? Sure! Here, this method guides you on importing PDFs into InDesign
directly. Although it may not have more advanced settings as a plugin, it's enough for basic needs. Without installing any plugin, you can efficiently convert PDF to InDesign. Followed is a list of simple steps for opening PDFs in Adobe InDesign: Step 1. Set up a new .indd document in this software and ensure the number of pages is the same as

your PDF. Step 2. Click "File" > "Place". When a dialog window appears, choose "Show Import Options". Step 3. Select the PDF you want to import. Finally, click "OK" to operate it. Why You Need to Convert PDF to InDesign It's not easy to edit documents like PDFs. Therefore, this Adobe design software becomes useful as it has various features to
help you edit content from these files. Before editing, you should get a .indd or .indt file on this software. There, conversion for PDF is a necessity if you want to enrich your project layouts and create extensive digital projects. Bonus Tips: How to Edit a PDF on Windows 10 We have shown you two solutions to convert PDF to InDesign and one method
to import PDF. Each method provides you with an editable .indd or .indt file. However, one limitation for .indd or .indt files is that you cannot simply share them with most devices. You have to output the files again, which increases cumbersome work. The EaseUS PDF Editor is a good helper for editing a PDF on Windows. Without complex steps, you
can directly edit your PDF and then save it on a PC. This PDF editor for Windows allows versatile features, such as highlighting a PDF, extracting images from PDF, reducing the size of files, etc. Now, try it for free! In the trial version, you don't need to register an account. Free DownloadWindows 11/10/8/7 Main features of this functional PDF
editing software: Unlike most designing software that specializes in editing, this tool is also the best PDF converter that helps you get more types of files. You can convert PDF into various formats like Word, Excel, image, PowerPoint, or vice versa. FAQs About PDF to InDesign Conversion To solve some frequently asked issues, the following are
related answers for your convenience. 1. How to convert PDF to InDesign online for free? Few PDF to InDesign online converters are supported in the market. There are only online ebook converters like ebook2pdf. While it may not support the INDD format. Therefore, you can follow the above guide to apply offline tools. 2. How to make an editable
PDF in InDesign? Firstly, use the plugins mentioned in this post to convert, which gives you a new type of editable file. The file contains your original content. You can also choose to import your PDF directly into Adobe InDesign. Go to "File" > "Place," and select "Show Import Options." Choose PDF as the option. Then, you can use editing tools on
InDesign to help edit. 3. Why can't I open a PDF in InDesign? There are some common reasons why you can't open a PDF file in InDesign: Unlike some other Adobe programs, InDesign treats PDFs as graphics to be placed rather than editable files. If the PDF is password-protected, InDesign will ask you for the password. The PDF file may also be
damaged or have security restrictions preventing it from opening correctly. 4. Is there any free PDF to InDesign online converter? Some PDF to InDesign online converters offer a free version, such as the LegUptools PDF to InDesign converter and Markzware PDF to InDesign. Locked Colin Flashman ¢ Community Expert, Oct 07, 2017 Oct 07, 2017
Let's make a distinction between getting a facsimile copy of the formatting from the PDF, placing a PDF into InDesign and getting the bare-bones content out of a PDF for formatting into InDesign.So far as getting a 100% accurate translation from PDF to InDesign, I would rethink this solution. There are two paid solutions, the first one has been
mentioned, the other is offered by Markzware: Markzware PDF2DTP Adobe InDesign plugins convert PDF to InDesign INDD Barbara's solution is good for taking... Jump to answer Be kind and respectful, give credit to the original source of content, and search for duplicates before posting. Learn more



